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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.   

 

The TReK Data application provides the capability to manage data services such as 

receiving data, processing data, recording data, forwarding data, and displaying data.   

 

This tutorial provides step-by-step instructions describing how to perform common 

application functions.   

 

The topics in this tutorial require an understanding of the topics covered in the TReK 

Concepts document.  Please be sure you have read the TReK Concepts document before 

proceeding with this tutorial. 

 

This tutorial uses screen dumps taken on a Windows computer.  However, the steps are 

the same regardless of whether you are running on Windows or Linux.   

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:            trek.help@nasa.gov 

Telephone:      256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time) 

Fax:                 256-544-9353 

 

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time.  The HOSC Help Desk (256-544-5066) can provide assistance as needed 

and is available 24x7. 

 

 

3 Introduction 

The TReK Data application provides the capability to manage data services such as 

receiving data, processing data, recording data, forwarding data, and displaying data.  It 

can be configured to receive different types of data from multiple sources simultaneously.  

The configuration can be saved. 

 

The Data application creates a TReK data store on application initialization.  The data 

store is used by the application to store incoming data so it can be accessed using the 
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TReK Telemetry Application Programming Interface (API).  When using the TReK 

Telemetry API, you will need the data store name.  The Data application uses 

“DefaultDataStore” as the default data store name.  If you start another instance of the 

TReK Data application, and the “DefaultDataStore” name is already in use, the 

application will prompt you to enter a new and unique name.  There is also an option 

within the application to change the data store name. 

 

 

 

4 Overview of the User Interface 

4.1 Main Window 

The main window consists of three main areas as shown in Figure 1.  The top part of the 

main window contains the list of services.  A Service is used to define a set of functions 

to perform.   When you start the Data application the list will be empty.  The middle part 

of the window is the Statistics area.  Once you activate one or more services, the 

Statistics area will display statistics information about each service.  It will also provide 

information about the functions being performed like how many packets were recorded, 

how many packets were forwarded, etc.  The Statistics area can be reconfigured to show 

several different views.  The bottom part of the window is a message area that is used to 

display important status and information messages about the activities in progress.   

 

You may have noticed that each service row has a color associated with it.  The color 

provides information about the service.  For example, when using the default colors, if 

the packet row is black, this indicates that the packet has not been activated.  If the packet 

row is purple, this indicates that the service is initializing.  If the packet row is blue, this 

indicates the packet has been activated but no data has arrived.  If the packet row is 

green, this indicates that data packets are arriving.  The colors are helpful in providing 

immediate information about the general configuration and status of each service in the 

list.  

 

Figure 1 shows two services in the Service area.  The first service in the list is named 

Science Data.   The Science Data service is configured to receive a data stream 

containing science data.   The status is Active and the color is green to indicate that data 

is arriving.  The second service in the list is named Health and Status Data.  The status is 

Inactive and the color is black.  This indicates that the service has been configured but 

not activated.  Until the service is active, the Data application is not prepared to handle 

the incoming data.  When a service is activated, it creates all the network sockets and 

other support needed to support the services requested.  As soon as a service goes Active, 

the application will start applying the configured services to support any data that arrives 

(processing, recording, etc.). 

 

The Statistics area and the Message Area are dock windows that you can float or dock.  

To float a dock window, use your left mouse button to click and hold the title area while 
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dragging the window to another area of the screen.  To dock, use the title bar to drag the 

dock window over the main window and drop. 

 

 

Figure 1 Main Window 

 

Data Store Toolbar 

The Data Store toolbar displays the name of the data store created by the application. 

 

Service Area 

The Service area provides a list of “Services”.  A Service defines a set of functions to 

perform. 

 

Statistics Area 

The Statistics area provides real time statistics information for active services. 

 

Message Area 

The Message Area displays important information, warning and error messages.  The 

message area can be cleared using the View menu. 

 

 

4.2 Menus 

The application menus are:  File, View, Service, Parameter, Options, and Help.  Each of 

these menus is described in more detail below. 

 

File Menu 
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The File menu provides the capability to create a new configuration, open a 

configuration, save a configuration, and exit the application.   

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide the main window statistics and message area.   

 

Service Menu 

The Service menu provides the capability to perform functions associated with services 

such as adding a service, activating a service, or deleting a service.  The service menu 

also shows context dependent menu items corresponding to the configuration of the 

service.  The context menu items will only appear when the service is active.  For 

example in Figure 2 there is a service selected that is configured to record data.  

Therefore, when the service is active and selected there will be additional service menu 

items to control recording.   

 

 

Figure 2 Service Menu Context Specific Menu Items 

 

Parameter Menu 

The Parameter menu provides access to parameter type capabilities such as displays and 

parameter monitoring. 

   

Options Menu 

The Options menu provides the capability to access statistics, reset statistics, configure 

statistics snapshot recording, and change the data store.  It also provides access to the 

Messages dialog which can be used to display and filter application messages.   
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Help Menu 

The Help menu provides access to on-line help and application version information. 

 

 

 

5 TReK Data Tour 

Sometimes it’s easier to learn how to use an application by example.  This section 

describes how to use the Data application to receive, process, record, and display 

incoming data.   

 

This section was written assuming you have read the Introduction section and the Main 

Window section.  If you have not read these sections, please go back and read them.  

They contain important information that is not repeated in this section.   

 

The tutorial requires the use of TReK 3.1.3 or a previous version of TReK Release 3 

software.  If you do not have a version of TReK Release 3 software, please download 

TReK 3.1.3 from the TReK Web Site and install it on a Windows computer (Win7 or 

Win10) to perform the steps in this tutorial. 

 

If at any time you need to exit the application so you can resume working through the 

Tutorial at a later time, File Save will allow you to save all the data you entered. 

 

Please go through the tour in order.  Some sections depend on data from previous 

sections. 

 

5.1 Step-By-Step 

This section provides step-by-step instructions that show how to configure the Data 

application to receive an incoming data stream, process the incoming data, and display 

the data.   

 

1. Go to the operating system’s menu to start the TReK Data application.  You should 

see the TReK Data main window shown in Figure 3. 
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Figure 3 TReK Data Main Window 

 

 

2. Go to the Service menu and select Add Service.  You should see the dialog 

shown in Figure 4. 
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Figure 4 Add Service Dialog 

 

 

3. In the Add Service dialog enter Packet 24 in the Service Name field as shown in 

Figure 5.  The Local IP Address should default to your local IP Address.  But 

you need to check it to be sure.  If it doesn’t default to the right address, please 

enter your local IP address.   All the other settings on this tab are set correctly. 
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Figure 5 Service Name Populated 

   

 

4. Select the Data Description tab as shown in Figure 6.   
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Figure 6 Data Description Tab 

 

 

5. The Filter should be set to Packet List as shown.  The Packet Type should be set 

to PdssPayload as shown.  Push the Browse Disk… button to select and add a 

packet to the packet list.  The packet information will be added by selecting a 

metadata file in the Open dialog.  The Open dialog will be displayed when you 

push the Browse Disk dialog and should default to the 

trek_workspace\metadata\telemetry_packet folder in your home directory.  Select 

the file named ‘pdss_pl_apid_24.xml’ and push the Open button to add this 

packet to the list.  The dialog should look like the one shown in Figure 7.  This 

step configures the service to identify and filter packets that are PDSS Payload 

packets with a Data Mode of Real-Time and an APID value of 24. 

 



TREK-USER-0020 

 10 

 

 

Figure 7 PdssPayload.RT.PL.24 Packet in Packet List 

 

 

6. Select the Process tab.  Your Process tab should look similar to the one shown in 

Figure 8.   
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Figure 8 Process Tab 

 

 

7. In the Process Tab, select the Yes radio button to indicate the incoming data 

should be processed.  You can see that the Packet List already contains the packet 

you added on the Data Description tab.  Figure 9 shows the configuration with 

processing on.  It also shows the number of buffers that will be used to store the 

incoming data for PdssPayload.RT.PL.24 defaults to 10 and the buffer length 

defaults to 0.  A value of 0 indicates the length should be calculated using 

information in the packet definition.  If you needed to change these values, they 

can be changed using the Configure button.  They are fine as is for this tutorial. 
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Figure 9 Processing Tab with Processing On 

 

8. Select the Record tab.  Your Record tab should look similar to the one shown in 

Figure 10.   
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Figure 10 Record Tab 

 

9. In the Record Tab, select the Yes radio button to indicate the incoming data 

should be recorded.  You can see that the Packet List already contains the packet 

you added on the Data Description tab.  Figure 11 shows the configuration with 

recording on.   
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Figure 11 Record Tab with Recording On 

 

 

Base Filename is used for part of the filename and the rest of the filename is 

generated by the TReK software.  The complete filename indicates the time the 

file was created and closed.  When you want to play the data back, you will be 

asked to provide this Base Filename.  Therefore, you should try to select a 

meaningful name that will be easy to remember and is closely associated with the 

data that you are recording.  The Directory information is used to identify which 

directory should be used for the recorded data files.  You can use the … button to 

select a directory.  The Open dialog will default to the trek_workspace 

recorded_data directory.  

 

Enter the following settings as shown in Figure 12. 
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Configuration:   Single Record Directory 

Base Filename:  Packet 24 

Base Directory:   <Home Directory>\trek_workspace\recorded_data 

 

 

 

Figure 12 Record Tab Populated 

 

 

10. Push the OK button in the Add Service dialog to close the dialog. 

 

11. Select Packet 24 in the Main Window as shown in Figure 13. 
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Figure 13 Packet 24 in the Data Main Window 

 

 

12. With Packet 24 selected, go to the Service menu and select Activate Service.  

Your Main Window should look like the one shown in Figure 14.  Now you have 

everything configured to receive and process the packet. 
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Figure 14 Packet 24 Activated 

 

 

 

13. In the Parameter menu, select Manage Displays.  You should see the dialog 

shown in Figure 15.   

 

 

Figure 15 Displays Dialog 

 

 

14. In the Manage Displays dialog, select PdssPayload.RT.PL.24 and push the 

Start button.  You should see the dialog shown in Figure 16.  Now you have a 
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display to see the processed data each time a packet is received. The Value and 

Status columns are empty because you have not received any data. 

 

 

Figure 16 PdssPayloadApid24 Packet Display 

 

15. Now we need to flow some data.  Go to the operating system’s menu to start the 

TReK Generator application.  You should see the Generator Main Window 

shown in Figure 17. 
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Figure 17 Generator Main Window 

 

16. In the Generator application, go to the Service menu and select Add Service.  

You should see the dialog shown in Figure 18. 

 

 

Figure 18  Generator Add Service Dialog 
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17. In the Add Service dialog enter Packet 24 in the Service Name field. 

 

18. On the Generate Tab select the Browse Disk button.  In the Open dialog that is 

displayed choose the pdss_pl_apid_24.xml metadata file and push the OK button 

to add it to the list.  The Generator application will use information in the 

metadata file to automatically generate data values for the packet contents.  Your 

dialog should look similar to the one shown in Figure 19.   

 

 

Figure 19 Add Service Dialog Generate Tab (Packet 24) 

 

19. Select the packet in the list and push the Configure button.  You should see the 

dialog in Figure 20. 
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Figure 20 Configure Generator Properties Dialog 

 

20. In the Configure Generator Properties dialog change the duration to 30 and then 

push the OK button.  You should see the duration has been set to 30 in the Add 

Service dialog as shown in Figure 21. 

 

 

Figure 21 Add Service Dialog Generate Tab 

 

21. Go to the Forward Tab.  In the Destination List Network Tab push the Add 

button to add a row to the table.  Enter the following information in the row to 

define a destination with details on where and how to forward the generated data: 
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Name Data 

Protocol UDP 

Destination IP Address 127.0.0.1 

Destination Port Number 6100 

Source IP Address 127.0.0.1 

Source Port Number 0 

 

 

 

22. Your dialog should look similar to the one shown in Figure 22.  Push the OK 

button to add the service.   

 

 

Figure 22 Generator Add Service Dialog Forward Tab 

 

 

23. Your Main Window should look like the one shown in Figure 23. 
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Figure 23 Generator Main Window with Packet 24 

 

24. Now that you have identified the telemetry packet to send, you can activate the 

service. In the Generator main window go to the Service menu and select 

Activate Service.  The service in the Generator will turn blue to indicate it is 

active and ready to generate data as shown in Figure 24.   

 

 

Figure 24 Generator Main Window Activated Service 
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25. Now that you have activated the service you can start the data flow.  In the 

Generator main window go to the Service menu and select Start Packets.  The 

service in the Generator will turn green to indicate it is generating Packet 24 as 

shown in Figure 25.  

 

 

Figure 25 Generator Sending Packet 24 

 

 

26. Look at the TReK Data Main Window.  The service named Packet 24 is green 

indicating it is receiving data as shown in Figure 26. 
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Figure 26 TReK Data Receiving Packet 24 Data 

 

 

27. Look at the PdssPayload.RT.PL.24 display.  The Value column should contain 

data values as shown in Figure 27.  The data value of each parameter in the packet 

is displayed on the display each time a new packet of data arrives and is processed 

by the Data application.  When you stop receiving data you will see the ‘S’ status 

character in the Status column to indicate the data is stale as shown in Figure 28. 
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Figure 27 PdssPayload.RT.PL.24 Packet Data Values 
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Figure 28 PdssPayload.RT.PL.24 Display with Stale Data 

 

 

28. In order to close the data recording file, select the Packet 24 Service in the Main 

Window and then go to the Service menu and select Stop Recording.  This will 

stop the data recording and close the data recording files.  You should see the 

following types of files: 

 

Packet 24_2017-05-10_21~24~59 

Packet 24.con 

 

The Packet 24_2017-05-10_21~24~59 file is the file that contains the recorded 

data.  The filename consists of a Start Time (the time associated with the first 
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packet in the file) and the Base Filename you provided when you set up the 

service.   

 

The Packet 24.con file is a configuration file that provides information about the 

contents of the data recording file.  It is important to keep this file in the same 

directory with the data recording file since it is used by the TReK Playback 

application during data playback.  

 

 

 

 

Congratulations – you have successfully completed the Tutorial! 

 

 


